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Logging In for the First Time 

 
1. Log into Business Access @ Busey with your Customer ID and User ID. 

 
2. Open the left navigation menu, click the plus sign to expand the Other Services menu, then select 

Bill Payment. 
 

3. Enter your Bill Pay User ID two times and Bill Pay Password (PWD) two times, then click Login. 

 
 

4. The screen should now resemble the screenshot below. 

 
 

5. You have successfully logged into Busey Bill Pay. You will not need to enter your login 
information again. Next time you log into Bill Pay, simply follow Step 1 above followed by Step  
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Users 

The Bill Pay product supports multiple users within a single business customer. 
Each user is assigned separate login and password credentials. There are three 
types of users: 

Administrator - The administrator has full access and privileges for all 
Bill Pay features and functionality. The business must have at least one 
active administrator at all times. The following privileges are available only 
to administrators: 

• Has full privileges, including maximum dollar limits and access to all 
approved funding accounts. 

• Can create automatic payment rules, schedule expedited payments, and 
manage other users' access and privileges. 

Authorized User - A user has a limited set of privileges and access to Bill 
Pay features. Users and user privileges are managed by an administrator. 

• Has limited privileges to perform various activities. 

• Privileges are established by an administrator and can be modified any 
time. 

o Funding account (access to one or more accounts)  

o Schedule payments & payment dollar limit  

o Approve payment & approval dollar limit Payee management 

o Payment reports  

Additional Contact - (Not commonly used) A business contact is a person 
authorized to contact Customer Service for assistance regarding the 
business Bill Pay account. However, an additional contact does not have login 
credentials and has no access to the Bill Pay platform. 

 
Add a User 

1. Click the More tab 
2. Click Authorized Users 
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3. Click Add Users 

 

 
 

4. Choose the type of User you want to add 
5. Click Continue 
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6. Enter the following info for the user Note: some fields will not be available for 
Additional Contact users 

• User id 
• Password 
• Confirm Password 
• First Name 
• Middle Initial (optional) 
• Last Name 
• Email address 
• Home phone – optional but is preferred 
• Work phone – optional but is preferred 

7. Click Continue 

 

 
8. A confirmation screen will appear 

• If an Administrator or Additional Contact was added, click Close. The process is 
complete 
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• If an Authorized User was added, click Close. Complete the below steps to add 
permissions 

 
a. Click the More tab and choose Authorized Users 

 
 

b. Click on the User that was added 
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c. Click Modify User 

 
 

d.  Update the below information 
i. Access – click the radio button next to Allow 
ii. Funding Accounts – check the box next to the account(s) the 

user should have access to  
iii. Authorizations – check the box(es) next to the permission(s) the 

user should have and enter limits for those permissions. Note: 
Limits will default to $9,999.99 but can be changed to allow the 
appropriate limit for the user 

iv. Reports -  check the box next to the report(s) the user should 
have access to 

e. Click Save Changes 

 
 

f. The User Details screen will appear, click Close. 
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Modify a User 

1. Click the More tab and choose Authorized Users 

 
 

2. Click the user you want to modify 

 
 

3. The User Details screen will appear. Click Modify User. 
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4. The Modify User screen appears. Update the information and/or Permissions for the 
user. Click Save Changes. 
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Delete a User 

1. Click the More tab and choose Authorized Users 

 
 

2. Click Delete next to the user you want to delete. Note: An admin can’t delete their own 
profile 
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3. The Delete User Screen will appear, click Delete User 

 
 

 
 
Payees 
Add a Payee 

1. Click Pay someone new 

 
 

2. The Add a Person or Business to Pay screen will appear. 
a. Add a Popular Biller in Your Area  
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i. Click the link for the payee you want to use 
• The screen with the payee info will appear. Enter or update the below 

information: 
o Nickname – Can be updated to display the nickname you 

would like to use 
o Account Number – Enter the account number for the payee 
o Hide Account Number checkbox – click if you would like to 

hide  
o Category – choose a category. Note: an icon will display next 

to this field based on the category chosen. If you want to 
change the icon, you will need to modify the category 

i. Add/Modify Category – this allows you to add a new 
category or modify an existing one 

ii. None 
iii. Auto 
iv. Credit Card 
v. Household 
vi. Miscellaneous 
vii. Utilities 

• Click Confirm 

 
 

• A Confirmation screen will appear.  
o Click Pay this biller if you are ready to pay the payee 
o Click Add another biller if you would like to add another 

payee 
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b. Enter Any Person or Business 
i. Enter the full name of the payee, click Add.  

 
 

ii. Enter or update the below information: 
o Nickname – Can be updated to display the nickname you 

would like to use 
o Account Number – Enter the account number for the payee 
o Hide Account Number checkbox – click if you would like to 

hide 
o Address line 1 & line 2 – these fields may only appear if the 

payee was not found, or additional information is needed to 
add the payee  

o Zip – enter the zip code for the payee 
o City, State, & Phone - these fields may only appear if the 

payee was not found, or additional information is needed to 
add the payee 

o Category – choose a category. Note: an icon will display next 
to this field based on the category chosen. If you want to 
change the icon, you will need to modify the category 

i. Add/Modify Category – this allows you to add a new 
category or modify an existing one 

ii. None 
iii. Auto 
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iv. Credit Card 
v. Household 
vi. Miscellaneous 
vii. Utilities 

• Click Confirm 

 
 

• A Confirmation screen will appear.  
o Click Pay this biller if you are ready to pay the payee 
o Click Add another biller if you would like to add another 

payee 
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Modify a Payee 
1. To modify a payee, click Modify from the pop out menu next to the payee in on of the 

following areas: 
a. Payee within Single Pay mode Note: if you have more than 300 payees, this option 

will not be available 

 
 
b. Payee within Multi-Pay mode 

 
 

2. The Modify Biller Details will display, update information for the payee. Note: if the payee 
is contracted with FIS, the address will not be available to update. 
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3. Click Confirm 

 
 
4. The Confirmation: Modify Biller Details screen appears, click Close. 

 
 

Delete a Payee 
1. To modify a payee, click Delete from the pop out menu next to the payee in one of the 

following areas: 
a. Payee within Single Pay mode Note: if you have more than 300 payees, this option 

will not be available  

 
b. Payee within Multi-Pay mode 
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2. The Delete Biller screen will appear, click Delete. 
 

 
 

 
Payments 
Making a Payment 

Single Pay mode 
1. To make a payment in the Single Pay mode, start from one of the following areas: 

a. Choose Pay from the Options drop-down menu 
i. Information displays in the payment section, enter the below information: 

• Pay to – this will display the payee name 
• Pay From – this will display the default account, use the drop-down 

to choose a different account 
• Category – defaults to None and can be updated using the drop-

down menu 
• Memo – optional field and can be used to include payment 

information that will display on the check memo line 
• Add a note – this is used to write a note to yourself that will be 

saved with the payment 
• Add an invoice – click this to include invoice information. Refer to 

“Adding an Invoice” section.  
• Deliver by – manually enter or use the calendar icon to enter the 

date you would like the payment delivered by 
• (Check) or (Electronic) – displays how the payment will be sent 
• Need to pay it faster? – use this link to expedite a payment. Refer 

to “Expediting a Payment” section. 
• Amount – enter the amount of the payment 

ii. Click Make payment 
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b. Enter the Payee in the Pay to: field 
i. Type the name of the payee in the “Pay to:” field. Note: as you type the 

name a list of related payees will display below the field, you can click on the 
payee there 

 
 

ii. Once payee is entered, additional fields will display. Enter the below 
information: 

• Pay From – this will display the default account, use the drop-down 
to choose a different account 

• Category – defaults to None and can be updated using the drop-
down menu 

• Memo – optional field and can be used to include payment 
information that will display on the check memo line 

• Add a note – this is used to write a note to yourself that will be 
saved with the payment 

• Add an invoice – click this to include invoice information. Refer to 
“Adding an Invoice” section.  

• Deliver by – manually enter or use the calendar icon to enter the 
date you would like the payment delivered by 

• (Check) or (Electronic) – displays how the payment will be sent 
• Need to pay it faster? – use this link to expedite a payment. Refer 
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to “Expediting a Payment” section. 
• Amount – enter the amount of the payment 

iii. Click Make payment 

 
 

Multi-Pay mode 
1. To make a payment in the Multi-Pay mode 
2. Enter and update the below information: 

a. Pay From – this will display the default account, use the drop-down to choose a 
different account 

b. Memo – optional field and can be used to include payment information that will 
display on the check memo line 

c. Add a note – this is used to write a note to yourself that will be saved with the 
payment 

d. Add an invoice – click this to include invoice information. Refer to “Adding an 
Invoice” section.  

e. Deliver by – manually enter or use the calendar icon to enter the date you would 
like the payment delivered by 

f. (Check) or (Electronic – displays how the payment will be sent 
g. Pay it faster?  – use this link to expedite a payment. Refer to “Expediting a 

Payment” section. 
h. Amount – enter the amount of the payment 
i. Repeat all steps until payment information is entered for all payees 

3. Click Confirm all payments 



21 
 

 
 
4. The Preview: Make Payment screen appears, click Confirm. 

 
 
5. The Confirmation: Make Payment screen appears, click Close. 
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Expediting a Payment 

1. Customer will click on the Payee Name 
2. On the right side under the date field, it will display if the payment type is being sent by 

check or electronically (see screenshots below) 

 

3. The Customer can click on one of the below options to expedite: 
a. Click “Need to pay it faster?” in the menu displayed by the Payee  
b. Click “Pay it faster?” on the right side under the payment type 

 

4. Once they click on one of the options the below screen will display 
a. Check 

i. the customer will fill in the payment info in the below screen and click 
Continue at the bottom. 

ii. The fee is displayed on the screen 
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b. Electronic 
i. the customer will fill in the payment info in the below screen 
ii. they will have a choice on which way they would like the payment to be sent  

• Expedite electronic 
• Overnight Check 

iii. Click Continue 
iv. The fee for each choice is displayed on the screen 

 

 
Modify a Payment 

1. Click the Activity tab 
2. Click on the payment you want to modify 
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3. The Payment Details screen appears, click Modify payment 

 
 
4. Update the information, click Modify 
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5. The Preview: Modify Payment Details screen appears, click Confirm 

 
 
6. The Confirmation: Modify Payment Details screen appears, click Close 

 
 

Cancel a Payment 
1. Click the Activity tab 
2. Click on the payment you want to cancel 

 
 
3. The Payment Details screen appears, click Cancel payment 
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4. The Preview: Cancel Payment screen appears, click Cancel payment 

 
 
5. The Confirmation: Cancel Payment screen appears, click Close 

 
 
Add an Invoice 

1. To add an invoice, click the Add Invoice link from one of the following areas: 
 

a. Payment form with a biller in focus within Single Pay mode.  
i. Click on the payee at top of screen Note: if you have more than 300 

payees, this view will not be available  
OR 

ii. Type the name of the payee in the “Pay to:” field and related payees will 
display to choose 
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b.  
 

c. Payee details menu within Multi-Pay mode. 

 
2. The Add Invoice screen will appear. Enter the following information 

a. Number 
b. Type – Invoice, Bill, Credit Memo, or Prepaid Check 
c. Description 
d. Invoice Amount 
e. Discount Amount (optional) 
f. Adjustment (optional) – Credit or Debit 
g. Net Total – this will display the final amount of the payment. 

3. Click Add Invoice 
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4. The payment screen will appear. The invoice information entered will display in the 

Invoices section. From this screen you can Modify or Delete the invoice prior to making 
the payment. 

5. Click Make Payment  
6. The Preview: Make Payment screen will appear. Click Confirm. Note: If user doesn’t have 

approval permission, then the process will be over and a user with approval permission 
will need to approve the payment.  

 
 
7. The Confirmation: Make Payment screen will appear. Click Close. 
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Approve a Payment 

1. Click the Approvals tab on the Landing Page.  
2. To approve a payment: 

a. Check the box next to the payment and click Submit  
OR 

b. Click on the payment 

 
3. The Payment Details screen will appear. Click Approve. 
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4. The Preview: Approval screen will appear. Click Continue.  

 
 

5. The Confirmation: Approval screen will appear. Click Close.  

 
 

View Payment Activity  
1. Click the Activity tab 
2. The below information will be displayed 

a. Scheduled payments 
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b. Total of all payments scheduled 
Note: you can change the list order by clicking on the column headings 

 
View Payment History 

1. Click the History tab 
2. The below information will be displayed 

a. Payments that have been processed and paid Note:  these payments can’t be 
modified or canceled 

b. Total of all payments paid 
Note: you can change the list order by clicking on the column headings 
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More tab 
Reports 

The below functions can be located by click Reports under the More tab 

 
View Reports 

1. The screen will appear and display the default report. The default report is set by 
modifying a current available report or by creating a new report and setting it as the 
default report. Note: the system defaults to Current Week which displays which dates 
are included until a different report is updated to be the default report.  

 
 
2. To view a different report: 

a. Click the drop-down arrow 
b. Choose the report you want to view from the View menu 

 
 

Modify a Report 
1. Choose the report you want to modify from the drop-down View menu 
2. Click Modify 
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3. The Modify Report screen appears 
4. Update the information, then click Save 

 

 
 

Download Transactions 
1. Choose the report you want to modify from the drop-down View menu 
2. Click Download 
3. Choose the transaction type and file format from the drop-down menu 
4. The files will download and usually display at the bottom of your screen to open 

 

 
 

Create a New Report 
1. Choose the report you want to modify from the drop-down View menu 
2. Click Create new report 
3. The Create Report screen appears, enter or choose the below information 
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a. Report title – Enter the name as you want it to appear in the View drop-down 
menu 

b. Save this as the default report – check the box if you want the report to be the 
default report 

c. Time Frame – choose the time frame of the transactions you want included in the 
report. Note: there are several choices to select from or you can choose custom 
dates.  

d. Subtotal – choose how you want the report to be subtotaled from the drop-down 
i. Do not subtotal – not total will be included 
ii. Month – will subtotal by month 
iii. Quarter – will subtotal by quarter 
iv. Biller – will subtotal by payee 
v. Category – will subtotal by category 
vi. Account – will subtotal by account 

e. Accounts – check the box(es) next to the accounts you want to include in the 
report 

f. Billers – check the box(es) next to the payee(s) you want to include in the report 
g. Payment statuses – check the box(es) next to the payment status(es) you want 

to include in the report 
h. E-bill statuses – check the box(es) next to the e-bill status(es) you want to 

include in the report 
4. Click Save 
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Hide/Show Chart 
1. Click Hide Chart to remove the pie chart 

 
 
2. Click Show Chart to display the pie chart 

 
 

Balance Worksheet 
1. Click the More tab 
2. Click Balance Worksheet 

 
 
3. The Balance Worksheet screen appears 
4. Choose the account you want to balance from the Account drop-down 
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5. Choose the date you want to display activity through Note: the balance sheet will include 

all activity through this date 
6. Check the Unscheduled eBills and reminders if you want them included on the balance 

sheet. Note:  Scheduled payments are included by default 
7. Enter the Balance of the account 
8. Click Add additional row  

a. Enter in a Description  
b. Check the box next to Payment or Deposit 
c. Enter the Amount 

9. The What’s Left line will show the ending balance 

 
 

Alert Preferences 
1. Click the More tab 
2. Click Alert Preferences 

 
 
3. The Alert Preferences screen appears 

a. Email Address - your email address will be displayed 
b. Email Format – choose the email format you want the alert emails to be delivered  
c. Check the box(es) next to the alerts you would like to receive. Note: if the box is 

greyed out, the alert type is required 
d. Click Save. 
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Add/Modify/Delete Categories 

1. Click the More tab 
2. Click Add/Modify Categories 
3. The Add/Modify Categories screen appears 

 
 

Modify a category 
1. The below information can be modified 

a. Name - click in the box of the category and update the name you want to change 
it to 

b. Category Icon - choose a different icon from the drop-down menu 
c. Click Save Changes 
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Add a category 

1. Click Add category 
2. Enter the name of the category you want to add in the blank Name box 
3. Choose a category icon from the drop-down menu 
4. Click Save Changes 

 
Delete a category 

1. Check the box(es) next to the category you want to delete 
2. Click Save Changes 
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Funding Accounts 
1. Click the More tab 
2. Click Add/Modify Categories 
3. The Funding Accounts screen appears with all funding accounts listed 
4. You can change the funding account by clicking Change default funding account 

 
 

 
 
 

If you need support on the Busey Bill Payment system, please contact us at the information 
below. 
 
 

Busey Treasury Management Support 
Contact Information 

TreasuryManagement@Busey.com 
800-749-7844 
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